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Overview 
Topics we'll discuss today: 
• Finding the right journal. 
• Preparing your paper for that journal. 
• Writing the paper. 
• Graphics (figures). 
• Peer review. 
• Responding to reviewers. 
Notes: In the previous lecture, I discussed the key sections of a journal paper and some of 
the things I have learned after 25 years of working as an editor. Today, I will continue by 
explaining some additional tricks that will make it easier for you to work with English 
research journals. In summary, these tips will help you understand how to find a journal 
that is likely to publish your paper, how to prepare your paper according to the 
specifications required by the journal, how to write your paper efficiently, how to deal 
with graphics (figures), and some important advice for working successfully with journal 
editors and peer reviewers. 

Find the right journal 
The right journal for your paper: 
• Has published papers similar to your paper. 
• Includes one or more papers that you cite in your paper. (If not, you may have chosen 

the wrong journal.) 
• Ask your colleagues for suggestions and warnings. 
• Will be good for your career: try to publish where researchers from around the world 

will read your research. (Good for guanxi). 
• Has a high impact factor (http://en.wikipedia.org/wiki/Journal_impact_factor): good 

for your mianzi, and respected by your colleagues. 
• Unless your research is exceptional, avoid journals with high rejection rates (e.g., 
Nature, Science). This is often stated on their Web site. 

 
Notes: The first step in finding a journal is to find one whose subject area is similar to the 
subject area of your research. If the subject of your research is not something the journal 
is interested in, they will not publish it even if the research and the writing are both of 
high quality. If you want to publish your paper in a specific journal, but none of the 
papers that you cite in your review of the research literature comes from the journal, this 
is often a clue that you need to choose another journal. (Journal editors also like to see 
evidence that you have read their journal, and citing one of their journal's papers provides 
proof.) This is not a 100% rule; it is only evidence that will help you decide. Your 
teachers and your colleagues are a good source of advice if they have already published 
papers in English journals: they can tell you which journals are most friendly to Chinese 
researchers and which ones may cause problems for you. Sometimes your colleagues 



may have guanxi that will help you to contact an editor. This is not required when you 
contact an English journal, but as is the case in China, it can sometimes make things 
easier. When you look for a journal, your goal should be to find a journal that will be 
good for your career. Such journals are ones that are read by many researchers from 
around the world who also work in your field. This can create good guanxi as well as 
friendships and very useful cooperation in the future. It is also important to look for 
journals with a good reputation, since this is good for your mianzi, for your career (better 
pay, more seniority, more funding), and for the respect of your colleagues. The "impact 
factor" is one way that journals are judged, and although there are many problems with 
this index of a journal's importance, it is a useful criterion. Unfortunately, the most 
prestigious journals (such as Nature and Science) also have the highest rejection rates: it 
is very difficult to publish in these journals, even if your research and writing are of high 
quality. Unless your research is truly exceptional, you may find it a more efficient use of 
your time to publish in less famous journals that still have a good reputation. Journals 
with unusually high rejection rates will often indicate this on their Web site, in the 
guidelines to authors. 

Preparing your paper for a journal 
To prepare your paper for a journal: 
• Read and follow the author guidelines on the journal's Web site. 
• If the guidelines are not clear, read papers in a current issue and follow the approach 

their authors used. 
• Before you publish your paper in a Chinese journal, obtain permission from the 

English editor: some will not accept this, but others recognize that important Chinese 
papers should be made available to an English audience. 

 
Notes: Preparing your paper for a journal can take a long time. In addition to all the 
difficult problems of analyzing your data and deciding how to write about it, each journal 
has slightly different requirements. The best way to learn these requirements is to look for 
the author guidelines on the journal's Web site. You should follow all these instructions as 
carefully as possible, because your paper may be rejected without being reviewed if your 
paper differs from the guidelines. Unfortunately, the guidelines are often not clear. In that 
case, find a current issue of the journal (no more than 1 year old) and follow the same 
approach that authors have used in one or more papers in that issue. Note that in English 
publishing, it is not acceptable to publish the same paper in two places. If you want to 
publish your paper first in a Chinese journal, ask the editor of the English journal if this is 
acceptable to them. Some will not permit this, but others will accept this because they 
realize that the Chinese version of your paper will not be available to most readers 
outside of China. It is often possible to publish your paper in Chinese journals after you 
have published it in English, because Chinese journals have different criteria for 
publishing. But again, this will depend on the journal, so you should ask the editor about 
their policy. 

Preparing your paper for a journal 
Prepare a simple word processor file: 
• General rule: Do not perform complex formatting. The journal will do this for you. 
• Typing: only use 12-point Times New Roman. If this is too large on your screen, use 



the "Zoom" tool (under the View menu) to change the magnification. 
• Use a smaller font only for large tables and graphics (figures). 
• Never use Chinese fonts: they are not available to English reviewers. 
• Use the Windows Character Map utility or the list of keyboard shortcuts on my site 

(http://www.geoff-hart.com/resources/accents-windows.pdf) to insert special 
symbols. 

• Set the line spacing to double-spaced for all parts of the manuscript. 
• Add line numbers and page numbers. 
• Turn off the "document grid" that is used for Chinese characters. 
 
Notes: Most journals now use sophisticated software that will prepare your manuscript 
for publication. This software will remove all of the formatting you have applied and 
replace it with the formatting that is used by the journal's publishing software. Thus, you 
should spend as little time as possible formatting your paper: that time is wasted because 
all your work will be undone by the software. As a result, keep your formatting as simple 
as possible. The best font (typeface) to use is Times New Roman, set to 12 points in size. 
If you find that this is too large for comfortable reading on your computer's screen, open 
the View menu, select Zoom, and change the magnification settings. This font is 
acceptable to any journal, and all journal editors and reviewers in the world will have this 
font on their computer. The only time you should use a smaller font is when you must fit 
a large table onto a printed page, or in figures. If you must type any special characters, 
use the Character Map utility provided by Microsoft Windows; I have also created a 
reference sheet that lists common special characters used by scientists that you can 
download from my Web site. Using Times New Roman and these two tools for symbols 
will ensure that anyone can read your paper and see all the special symbols you type. 
Whenever possible, avoid using Chinese fonts; these are often not available to English 
reviewers, and they can cause printing and screen display problems. To prepare your 
paper for review, set the line spacing to double-spaced for all parts of the manuscript. 
Add line numbers and page numbers to every page, since this helps reviewers to tell you 
which part of the manuscript their comments describe. In addition, turn off the "document 
grid" feature (in the Page Setup dialog box) that is used to align Chinese and other Asian 
fonts on the screen. This can cause serious display problems for English reviewers. 

Preparing your paper for a journal 
English formatting is more complex than Chinese formatting: 
• Add spaces between words. 
• Add spaces before units of measurement and before brackets: ( ), [ ], or { }. 
• Add spaces after punctuation (never before punctuation). 
 
Notes: This should be fairly straightforward to explain, but again, if you find anything 
that you think will not be clear to the students, please tell me so I can fix the problem. 

Writing your paper 
To write your paper efficiently: 
• Perform your analysis and create your outline in Chinese first. This is faster than 

starting the work in your second language (English). 
• Wait at least 1 day (2 days is better) before you revise this information. 



• Even when you are eager to publish, always revise your plans at least once. 
• Ask your colleagues to review your plan. (Guanxi = help each other; mianzi = avoid 

embarrassment.) 
 
Notes: Unless you have a large amount of experience writing in English, you may find it 
easier to perform your analysis and develop your outline first in Chinese, since you are 
then working in a language you are very comfortable using. Once you have written your 
first draft of this information, try to wait at least 1 day (2 days is better) before you try to 
revise your plans. One fundamental aspect of human psychology is that allowing time to 
pass will let your subconscious mind think about the paper and find ways to understand it 
better. When you return to the plan, you will see many problems (and solutions to many 
problems) that you did not see the first time. Even when you are eager to publish your 
research results, you should always plan your schedule so that you have time to revise 
your plan at least once. This seems obvious, but sometimes the pressure from your 
teacher or your colleagues to publish becomes very strong, and some authors choose not 
to revise their plan. Ask your colleagues to help you revise your paper: guanxi means that 
you will help each other to protect your mianzi by solving problems before they can 
embarrass you in front of reviewers. 

Writing your paper 
Once your plan is satisfactory: 
• Translate your plan into English, then begin writing. 
• Ask another colleague to read your paper. If they cannot understand, the journal and 

its reviewers will not understand. 
• Instead of typing references (literature citations), copy and paste them from 

trustworthy databases: 
– the journal's Web site 
– Ingenta (http://www.ingentaconnect.com/) 
– Science Direct (http://www.sciencedirect.com/) 

• Format the references correctly or your paper may be rejected: format the author 
names first, then the years, then the titles, then the journal names. 

• Use reference-manager software such as EndNote (http://www.endnote.com/) to make 
this easier. 

 
Notes: When you have reviewed your plan in Chinese, it will be of satisfactory quality to 
you and your colleagues. Now you can translate the plan into English and begin writing. 
Even if your English is very good, you should ask one or more of your colleagues to read 
it and point out anything that is unclear. If your colleagues cannot understand what you 
have written, the English journal editor and reviewers will also have difficulty 
understanding what you have written, and they may reject your paper without performing 
a peer review. Literature citations are a serious problem, for many reasons, including 
unfamiliarity with the English language. The simplest solution is to copy and paste (using 
these software features, which are usually under the Edit menu of most software) the 
references from a reliable source. The Web site of the journal that published a paper is 
usually a good source, but there are many other reliable databases, including the Ingenta 
and Science Direct services. You will still have to format the references according to the 
journal's specifications, but at least there will be no typing errors. Formatting is 



important, because journals do not have large editorial staffs, and they do not want to 
work very hard to apply the correct formats; if too much work is required, they may 
reject your paper. Formatting is very time-consuming, but necessary. The best way to do 
this task is to concentrate on one aspect of each reference at a time. For example, format 
only the author names for all references, then start over at the beginning and format the 
years, then start over and format the titles, and so on. If you cite many references in each 
of your papers, you may find it easier if you purchase special software for managing and 
formatting references; EndNote is one of the most popular programs for this purpose. 

Graphics (figures) 
To create acceptable graphics: 
• Don't use Microsoft Word or Powerpoint: use CorelDraw, Adobe Illustrator, or other 

software designed to create graphics. 
• The journal's author guidelines specify the minimum type size, line thickness, colors 

and fill patterns, and file format. 
• Submit graphics at the final size: large enough to fit within 1 or 2 columns of the 

page. 
• Always print a copy to ensure that it is readable at the size you used and that no 

symbols print incorrectly. 
 
Notes: Graphics are difficult to create, and cause many problems during the journal's 
review process. To create graphics that are acceptable to a journal, start by using the 
correct software. Microsoft Word or Powerpoint are generally not accepted because they 
create nonstandard graphics formats. Instead, use specialized graphics software such as 
CorelDraw and Adobe Illustrator, or other software specifically designed to create 
graphics. The journal's author guidelines will provide specifications for the minimum 
type size, line thickness, colors and fill patterns, and file format. They will also specify 
the size of the columns of words that appear in the printed journal. To avoid problems 
with graphics quality that occur when a graphic must be reduced or enlarged to fit within 
the available space, always send your graphics to the journal at their final size; this 
usually means that the graphic will fit perfectly in 1 or 2 columns. To ensure that the 
graphic will have acceptable quality, always print a copy. If it is difficult to read, or if any 
symbols print incorrectly, solve the problem before you send your paper to the journal. 

Graphics (figures) 
To create acceptable graphics: 
• Use the same axis scales for graphs that present values for the same parameter. 

(Authors often misinterpret their own data when the scales differ; readers definitely 
do.) 

• Define symbols and colors in a key instead of describing them in the figure caption. 
• Use the Windows Character Map utility or my PDF file to insert correct symbols. 
• Color printing is very expensive. Use black, white and grey graphics, and present 

color material only on the journal's Web site. 
 
Notes: Use the same y-axis and x-axis scales for all graphs that present values for the 
same parameter. When the scales differ, particularly when two graphs are side by side, it 
is very easy to fail to see that the scales are different. At least 2 or 3 times per year, I edit 



a paper in which the authors misinterpreted their own data because they forgot that the 
scales were different. If authors make this kind of mistake, you can be certain that readers 
will also make these mistakes. When you define the symbols and color patterns that are 
used in a graphic, always present this information in a "key" (sometimes called a 
"legend") that is inside the graphic. If you define this information in the figure caption, it 
is more difficult for readers to understand, and can lead to serious problems when the 
word processor file is processed by the journal's automated publishing software. To insert 
special characters or symbols, use the Windows Character Map utility or the PDF file on 
my Web site (see the previous slide about typing your manuscript). Color printing is very 
expensive, and publishers often use this cost as a way to pay the cost of publishing their 
journal. In most cases, you can use combinations of black, white, and grey to present 
your information, and this will save you hundreds of U.S. dollars in publication costs. If 
color graphics are necessary to communicate your results, you can almost always present 
the color graphics as "online supplemental material" on the journal's Web site. There is 
usually no cost to do this. 

Peer review 
Peer review has two main goals:  
• First: quality control (to avoid publishing bad research results and faulty conclusions). 
• Second: to protect your reputation by eliminating errors and helping you to produce 

the best paper you can write (mianzi). 
 
Notes: Before any paper can be published, it must undergo peer review. This is a process 
in which your colleagues (other researchers) rigorously evaluate and criticize your paper  
to ensure that the quality of your research and logic is high. The goal is to prevent bad 
research results and faulty conclusions from entering the literature, since they can 
subsequently mislead future researchers into wasting time and money. A second goal to 
protect your reputation by eliminating errors and helping you to produce the best paper 
you can write (mianzi). 

Peer review 
Things to expect from peer review: 
• At least one revision will be required, and often two or three revisions. 
• You may need to do more research to provide additional data. Sometimes you can 

cite other published studies instead of your own data. 
• Contradictory reviews: different reviewers will have different criticisms. 
Human biases also affect the peer review process: 
• Some reviewers reject theories that differ from their personal theories. 
• Competition for funding or for reputation (publishing a finding before anyone else) 

may lead to unusually critical reviews. 
• There is some prejudice against Chinese authors; this may be automatic, when they 

see your mailing address. 
 
Notes: Review by a journal is a difficult and time-consuming process. You can expect 
certain things to happen every time you send your paper to a journal, or at least many 
times. First, papers are almost never accepted in their original form. Most papers require 
at least one major revision, and sometimes it will take two or three revisions before your 



paper is accepted. Reviewers will sometimes ask you to do more research to provide 
additional data to support your conclusions or compensate for weak parts of your 
experimental design. Sometimes, if you are lucky, this will not be necessary because  you 
can cite other published studies instead of obtaining your own data. The most serious 
problem is that humans are unpredictable, and not always as logical as you would expect 
from scientists. Contradictory reviews are common, and you will often find that different 
reviewers have extremely different criticisms of your paper; sometimes one reviewer will 
accept your paper with only minor changes and another reviewer will reject it or require 
major changes. You must also be aware that researchers have their personal biases: some 
reviewers may reject your theories if those theories differ from their personal theories. In 
one case, I experienced a situation in which competition for funding or for reputation (the 
right to publish a research finding first) led to a severely critical review that was not 
justified. The last thing to be aware of is that you should expect occasional prejudice 
against Chinese authors. I have seen a journal editor reject a paper that I edited and send 
it back for language editing just because they saw a Chinese mailing address at the top of 
the paper. There is little that you can do about this other than ask for assistance from an 
English editor or an English colleague who is willing to help you with your English. 

Responding to review comments 
Chinese understand mianzi and Westerners do not. Thus, they may seem rude and critical. 
When you reply: 
• Never attack or embarrass reviewers, even if you believe they are wrong or are 

prejudiced against you. 
• Reviewers always have the final decision, so you must persuade them you are right. 
• Journal editors rarely settle disputes between authors and reviewers (they worry that a 

reviewer will not work for them again). 
• Always accept comments that don't affect you greatly (e.g., cite a paper that the 

reviewer recommended, use the reviewer's suggested wording). 
• Find ways to accept comments you disagree with slightly (e.g., report the reviewer's 

interpretation as a viable alternative, then say "further research required to determine 
which interpretation is correct"). 

 
Notes: Chinese understand mianzi and Westerners do not. As a result, Western reviewers 
often seem very rude and critical to Chinese authors. When you reply to their criticisms, 
it is natural to be angry or offended, but you should resist the temptation to respond 
equally rudely. Never attack or embarrass reviewers, even if you believe they are wrong 
or are prejudiced against you. Reviewers always have the final decision, and if you anger 
or frustrate them, they can easily reject your paper. Instead, you must persuade them that 
you are right. Journal editors will rarely risk offending a reviewer by trying to settle 
disputes between you and the reviewer. There are many reasons for this, but one of the 
most important ones is that they worry a reviewer will not work for them again if the 
reviewer's advice is ignored. One way to satisfy reviewers is to always accept comments 
that don't affect you greatly, even if this requires you to do some work. For example, 
always cite any paper that the reviewer asked you to cite, and use the reviewer's 
suggested wording if it seems to be acceptable, even if you would prefer to say something 
differently. Always look for ways to accept comments that you disagree with only 
slightly. There are several ways to accomplish this. For example, you can report the 



reviewer's interpretation as a viable alternative, even if it contradicts your beliefs, and add 
words such as "further research is required to determine which interpretation is correct". 

Responding to review comments 
To conclude your response letter to the reviewers: 
• Thank the reviewers for helping to improve your work: only at the end of your 

responses, not after each comment. 
• State that you hope the paper is now acceptable, but that you will be happy to 

continue working with them to solve any remaining problems. 
• If you're certain that you are right and one or more reviewers won't accept your logic, 

find a different journal. One journal may quickly accept a paper that another journal 
rejects. 

 
Notes: Deciding how to conclude your response letter to the reviewers can be difficult, 
but there are some simple steps that you should consider. First, thank the reviewers for 
helping to improve your work, but only do this at the end of your responses, not after 
each comment. If you say "thank you" too often, reviewers may think you are not being 
sincere. ("Sarcasm" is very common in the West, but uncommon in China.) State that you 
hope your revised paper will now be acceptable, but emphasize that you will be happy to 
continue working with the reviewers to solve any remaining problems. Lastly, if you are 
certain that you are right and one or more reviewers is wrong, but they won't accept your 
logic for why you are right, there is not much you can do about this. Find a different 
journal to review your paper. I have found that a second journal often quickly accepts a 
paper that the first journal rejected. 


